Building Emotion:
The Basics of the Eyes

The brows and the eyes tell us what we need to know about a character's thoughts. Primarily, the brows have two major movements, brows Up/Down and brows Squeeze. The brows Up/Down alone don't tell us a whole lot about emotion; they are used in conjunction with the brows Squeeze and different combinations of the lids. Generally, brows Squeeze is in every emotion; regardless of type of emotion, it denotes thought.

The upper lids tell us the alertness of a character, and the lower lids intensify emotions. The eyeballs mainly just communicate where a character is looking. The subtext of that can lead to some powerful emotion, but the eyeballs themselves don't say a whole lot; it's the entire eye area acting together that creates a feeling. That being said, the effect of the angle of the head itself can make all the difference in the world to an expression. It can change the viewer's perception of all the things listed above.

If you need a refresher introduction for any of these topics, take a peek back at Chapters 2 and 3; you should find all that you need.

- Building an upper face for practice
- Rules of the eyes and brows game
- Example animations
Building an Upper Face for Practice

In Chapter 1, “Learning the Basics of Lip Sync,” you created a simple mouth to work with and got a taste of the mouth setup in action. We didn’t do the same thing for the eyes in Chapter 2, so we’ll do it here. Many of the behaviors of the eyes are better to see and do yourself than to have me explain them. It really is much better if you can play along.

Everything to do with emotion is subjective. The same choices made for scene A could be all wrong for scene B. This section is going to boil down to the choices I would make in certain situations and the reasons why.

Modeling the Pieces

The face I’ll use to describe how the eyes and brows work is called Box Head, shown in Figure 7.1. You can load this scene from the Chapter 7 folder on the companion CD, BoxHead.ma.

I recommend that you actually go through and construct Box Head by yourself. In Chapter 12, “Interfaces for Your Faces,” I talk about expressions, and some more intricate work with expressions, but the majority of setting up your more complicated character is done with the automatic setup buttons (you’ll learn about those in Chapter 12). By doing the work here yourself, you can get some good easy practice in expression writing, which, if you want to design your own interfaces, you’ll need to know!

We’re going to construct and rig an extremely simple eye area for you to see the concepts I explain. We’ll build the face “backdrop,” cut out eyes, make flats to represent the brows and eyelids, and make a sphere and flatten it for our eyeballs. After that, we’ll load in the spline mouth from Chapter 1 and give Box Head a mouth!

The Face

Create a plane of Width 1, Height 0.4 with 10 subdivisions along the width and 4 along the height. By choosing the Z axis option, the plane will be created facing forward in the front view, where we’ll do our work with this face.

Planes can be created by selecting Create ➔ Polygon Primitives ➔ Plane.

Delete the faces that are missing from Figure 7.2. Select the outside edges of the holes and scale them down in Y. Now select the points that define the top of the holes and pull them higher. These will be our eye sockets. Select all the points around the outside perimeter of...
the grid and scale them out—we want the “face” to have a bigger edge around it. Make the lower edge reach farther than the others, as in Figure 7.3; the mouth will have to live there eventually. Rename the plane “Face.”

The Brows
Create another polygonal plane, this time of Width 0.4, Height 0.1, with subdivisions along width and height of 1. Move this shape to –0.25, 0.2, 0.2 in X, Y, and Z respectively. This is to be our right eyebrow. Create a lambert material and make it black.

There are many ways to create a material. The fastest is to right-click over the object and select Assign New Material from the bottom of the marking menu.

Rename the plane “RBrow.” Duplicate RBrow, and move it to 0.25, 0.2, 0.2. That should place it on the other side of the face. Rename it LBrow. You should start to see the beginnings of a very simple face (Figure 7.4).

The Upper Lids
Create yet another plane, this time of Width 1, Height 0.25, with subdivisions of only 1 in both width and height. Move the new plane to 0, 0.2, 0.01 (Figure 7.5). Rename the plane UprLids.

The Lower Lids
Duplicate the upper lid(s) and move it down to –0.225 in Y (Figure 7.6). Rename it LwrLids. Make both eyelids children of Face and then freeze the transformations of the eyelids (Modify ➔ Freeze Transformations). This is done so that later, when we apply expressions, we can be sure the lids’ translations at default are 0, 0, 0.

When freezing transformations, if it doesn’t seem to work, you may need to check your settings in the option box to make sure that all boxes (scale, rotate, translate) are checked.
The Eyeballs
Create a polygonal sphere of Radius .8, subdivisions along axis of 20, along Height of 4, and make it native to the Z axis. Move the sphere to –0.25, 0, –0.01. Scale the sphere to 0.1, 0.1, 0.01. You should have a very flat sphere sitting in the right eye socket of your face. Rename the sphere REye, and assign it the same material of the eyebrows, black.

Since we already have a material created, right-click over the object and from the Marking menu at the bottom select Assign Existing Material, then select the material you created for the brows.

Duplicate the eyeball and move it across the other side to 0.25, 0, –0.1. Rename the new object LEye. Your new practice face should look like Figure 7.7.

Save before you continue, just in case any problems arise. The one last thing to do is import your spline mouth from Chapter 1 (or load it from the CD). It should show up right in the middle of Box Head. If it doesn’t, feel free to move it into place. Select Mouth (the spline itself), and then Face, and parent them, making Mouth the child of Face. Move Mouth to 0, –0.3, 0.1 and scale it to 0.25 uniformly. Duplicate Mouth and scale the duplicate to 0.01 uniformly—very, very small (Figure 7.8). Now, be sure you have construction history turned on, and loft Mouth and Mouth’s duplicate together. Once this is done, turn construction history back off. Now, so you can see it, assign the black lambert material to the loft, and you’re ready to go!

Parenting Our Face Together
Now that we have the pieces we need, it’s time to rig them up for use. First, let’s start with the eyeballs. Create a locator and scale it to 0.1, 0.1, 0.1 so that it’s very small and not too obtrusive. Duplicate the locator and name the duplicate “Eyes.” Make both REEye and LEEye children of Eyes and then make Eyes a child of Face. We will use this locator to control our eyes’ positions in the sockets.

Duplicate the original small locator and rename the duplicate Brows. Parent both eyebrows to Brows and make Brows a child of Face.

Rigging Our Face
The first thing we’ll need to do is create a slider control, similar to the one we made in Chapter 1 for the mouth, so we can control the things that we need to.

Creating Our Control
We’ll make one slider control out of a locator and circle that we’ll duplicate for the other ones we’ll need. We’ll make one slider control out of a locator and a circle, and duplicate it to create the other ones we’ll need.
Create a locator, scale it to 0.25 uniformly, and move it away from the face. Rename the locator Ctrl_Prnt. Now create a NURBS circle of Radius 0.1 and native to the Z axis. Make the circle a child of Ctrl_Prnt and rename the circle “Ctrl.” If you now type zeros into the translate channels for the circle, it should center itself on Ctrl_Prnt (Figure 7.9).

In the Attribute Editor, limit Ctrl’s motion so that it can only travel between –1 and 1 in X and Y axes and cannot move in Z, a minimum-maximum limit of 0 and 0. Now, with Ctrl still selected, open the Channel Control (Window ➔ General Editors ➔ Channel Control). Select all but translateX and translateY from the left-side window and hit the “Move” button on the bottom-left side of the window. Now, the only attributes you’ll see for Ctrl are translate X an Y. Go ahead and close the window.

The circle is now going to be used as a slider with which we can control aspects of the face! You can move the slider’s location without affecting its output value by moving it from the Ctrl_Prnt level. Ctrl_Prnt can be anywhere you like in your scene, just as long as...values for the Ctrl itself are 0 and 0 in X and Y; or we’ll use those attributes to drive our expressions.

**Rigging the Face Control**

Duplicate the Ctrl_Prnt hierarchy (the locator and circle, both) and rename the duplicate circle Ctrl_Face. (The locator’s name is of no real consequence.) Select Face, and in the Channel Box click the rotateY attribute. If you then right-click, you can select Expressions from the menu that appears.

In the Expression Editor, type:

```
Face.rotateY = Ctrl_Face.translateX * 15
```

When you’ve typed that in, hit the Create button on the bottom-left corner of the window to create your expression. Now, click another attribute of Face’s—which attribute doesn’t matter. Enter the following in the expression window:

```
Face.rotateX = Ctrl_Face.translateY * -35
```

You can enter any expression in the Expression Editor in relation to any object and attribute at any time. The only danger in doing so is overwriting another expression that you’ve just written. To keep that from happening, you need to clear the window; to clear the window, you just have to select an attribute that has no expression.

Figure 7.9
A NURBS circle is the slider of choice for most of my setups; by hiding locators, selection is easy.
Throughout this chapter, remember to select the circle, not the locator!

As before, hit the Create button to make your expression take effect. If you close the Expression Editor, you should be able to drag the Ctrl_Face slider left, right, up, and down and see the whole face move, as in Figure 7.10. Set the slider to 0,0 and we’ll continue with our setup.

**Rigging the Eye Control**

Duplicate the original Ctrl slider hierarchy again (not the one with Ctrl_Face), and move it away so it has its own space. Select the circle and rename it Ctrl_Eyes.

Select the locator that is parent to both eyes; it should be named Eyes. In the Expression Editor, enter and create both these expressions, one at a time:

- `Eyes.translateX = Ctrl_Eyes.translateX / 10`
- `Eyes.translateY = Ctrl_Eyes.translateY / 10`

As before, create both expressions and then close the window. When you move the new Ctrl_Eyes slider around, the eyes should move (Figure 7.11). Once that’s working, set the Ctrl_Eyes slider to 0,0 and keep moving along.

**Rigging the Upper Lids**

Duplicate the original Ctrl hierarchy, move it away to its own spot, and rename the circle Ctrl_Lids. Select UprLids, and enter the following expression:

- `UprLids.translateY = (Ctrl_Lids.translateY / 5)`

Notice the parentheses; they’re there because of how we’re going to change this expression in just a moment. When you move the Ctrl_Lids slider, its up and down motion should control the upper eye lids’ height. There’s one problem, though. Select the Ctrl_Eyes slider and move it around. See how the eyes are moving around and the lids are not relating to them? Figure 7.12 shows that when you pull the EyesCtrl slider up, you have a sleepy-eyed character, and when you pull it down, you have an alert character. Now, maybe for some people that’s good enough, but not us. Knowing what we know about lids and eyes’ relationships, this expression needs work.

Having read Chapter 2, we know that the upper lids should follow the eyeballs’ motion so that we aren’t spontaneously changing expression like this. I was animating this effect manually myself for over a year when a friend of mine who also was doing the work of facial setups smartly decided that maybe this should be automated, as it’s something you always want to happen. Taking his lead, we’ll need the upper lids to consider the **eyeball** movement as well.
Since we want to mimic the eyes’ motion as well as what we’re doing already, the easiest thing is to simply add the eyes’ expression into the lids’ expression we already have. On UpLid, change the expression from this:

```
UpLids.translateY = (Ctrl_Lids.translateY / 5)
```

to this:

```
UpLids.translateY = (Ctrl_Lids.translateY / 5) + Ctrl_Eyes.translateY / 10
```

When you modify an expression instead of creating it, you must first select the object and attribute so the old one appears. When you’ve finished with your changes, you click the Edit button instead of the Create button to update it.

Now if you test the Ctrl_Lids up and down motion, you’ll see that it does the exact same thing as before. The difference is apparent when you use the Ctrl_Eyes slider. The lids now move up and down with eyeballs, too! To reiterate, all we did to create this effect was to add in the same math we’re doing for the eyes themselves.

---

This expression leaves something to be desired, since, if the eyes look all the way up, the upper lids can’t close to the bottom. For the level this face is at, that’s an acceptable flaw. In the automatic setup, there’s a more robust expression for the upper lids’ movements. For most of the Ctrl_Lids slider’s movement, it behaves like this, but for the last part of the slider’s range, the expression calculates the total remaining distance between upper and lower lids, and moves to a percentage of that distance, based on the slider’s value.” Closed will always mean closed regardless of where the eyes are, but the lids, when opened, will follow the eyes’ motion as well.

---

**Rigging the Lower Lids**

You may have noticed that in the two previous sliders, up and down have an effect as well as left to right. For our Ctrl_Lids slider, the up and down movements control the upper lids and the left to right motions control the lower lids.

Select the plane named LwrLids and type in the expression:

```
LwrLids.translateY = -Ctrl_Lids.translateX / 5
```

This merely links LwrLids to the left and right motion of that same slider used for the upper lids; don’t miss the minus sign! Moving the Ctrl_Lids slider up, down, left, and right can create all sorts of combinations for the eyelids (Figure 7.13).

---

**Rigging the Brows**

As with all the other pieces, we’ll need to create a control for the brows. Duplicate the original Ctrl_Prnt hierarchy again and rename the new circle Ctrl_Brows.
Select the brows’ parent object *Brows* and enter the following expression:

\[
\text{Brows} \text{.translateY} = \frac{\text{Ctrl_Brows} \text{.translateY}}{15}
\]

That will make the eyebrows move up and down. Now, we need to fake some emotion. I’ve talked a lot about what is and is not right on a human face, but this is decidedly not very human. For this face, and an introduction to the interface style and practice, I’m going to go with some more classic cartoony poses. Select LBrow and add the following expression:

\[
\text{LBrow} \text{.rotateZ} = \text{Ctrl_Brows} \text{.translateX} \times 10
\]

And to the right brow add the same, but with a minus sign in front of the expression, so that the right brow does the opposite:

\[
\text{RBrow} \text{.rotateZ} = -\text{Ctrl_Brows} \text{.translateX} \times 10
\]

What that added, effectively, was the ability to set sad and mad poses like those in Figure 7.14.

### Re-Rigging the Mouth

To fit in with our new control scheme, let’s connect the mouth to a slider like the other kids. You can now use Ctrl itself, and not a duplicate, as this is the last slider we’ll need for Box Head. Rename Ctrl to Ctrl.Sync, and you’ll need to make one more adjustment. Open the Attribute Editor and limit Ctrl.Sync’s motion in Y, so the maximum is 0. Now, select Mouth, open the MouthShapes node under the inputs (below the Channel Box), then select and right-click over WideNarrow. Once in the Expression Editor, select WideNarrow from the list on the right, and in the Expression that appears, rewrite the whole thing to read:

\[
\text{MouthShapes} \text{.WideNarrow} = \text{Ctrl.Sync} \text{.translateX}
\]

And then change the expression on the OpenClosed attribute to:

\[
\text{MouthShapes} \text{.OpenClosed} = -\text{Ctrl.Sync} \text{.translateY}
\]

You’ve now got yourself one rigged-up face that works very similarly to the more complicated setups later on. For ease of use (and the reason we moved the expression on Mouth over to a new slider), you can now, if you like, turn off locators’ visibility (Show ➔ Locators (Off)), and you won’t select the wrong things, just your new sliders. Also, if it makes it easier for you to differentiate them, reshape the circles to be more like icons as I’ve done in Figure 7.15, or label them.

---

**Figure 7.13**
Different slider positions yield interesting expressions.

**Figure 7.14**
The brows’ control in different positions can create most anything you might need on such a simple character.
Using “Box Head”

The best thing I can do for starters is take you through some examples of things like the tilt of the head, and the eyelids following the eyeballs, which you’ve heard about but not yet seen in action. Here I’ll acquaint you with the tools, and then we’ll use the face to create some expressions and emotions, so you can see in practice how things work.

The tilt of the head, in action  Just do it. Just move the Ctrl_Face slider up and down to alter the tilt of the head, and watch as the eyeballs’ relationship to the brows changes dramatically, due to distance relationships and perspective (Figure 7.16). This is how I recommend getting most of the brow up/down effects, by moving the head rather than the brows. Granted, the proportion in this setup is as if our character had a 4-inch forehead, but it does make the point, and gives you something very obvious to practice with.

The eyelids following the eyeballs  Take the Ctrl_Lids and slide it downward so that your new character looks unimpressed or sleepy (Figure 7.17). Now move the EyesCtrl around, and watch the lids follow—no matter where the eyes are looking. Even on this simple face the added reality of the lids tracking is pretty neat, but when you get this on a realistic face it’s creepy. I find myself playing with this part of the setup for hours, even though I’ve seen it a hundred times before.

Adding the lower lids  Go ahead and create yourself a little angry face. Pull Ctrl_Brows down and to the right, tilt the head forward to condense the space between the Brows and Eyes further, and take a look (Figure 7.18). Now move Ctrl_Lids to the left, adding some squint into the mix. Bounce back and forth including, and not including, the squint, to see the big difference it makes. As I’ve said before, it intensifies this as well as any other expression.

Okay, playtime’s over for now, but to keep you fresh on the uses of things, Table 7.1 is a cheat-sheet for Box Head’s interface.

Rules of the Game

Our eyes move around a lot. They move around to look at different things we need to know about, or just want to observe. Our eyes also sometimes move not just to things, but away from them as well. Avoiding eye contact or shielding ourselves from things too bright are reasons our eyeballs would be doing some avoiding. I’ve said before, and I’ll elaborate now, that the eyes themselves tell us next to nothing about emotion. It’s all in the context, and it’s all in the timing.
Table 7.1

<table>
<thead>
<tr>
<th>CONTROL ACTION</th>
<th>FACE ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl_Face up/down</td>
<td>Tilts the entire head forward and back. Condenses and expands the vertical</td>
</tr>
<tr>
<td>Ctrl_Face left/right</td>
<td>turns the head left and right, only in a limited way because this face is</td>
</tr>
<tr>
<td>Ctrl_Eyes up/down</td>
<td>Moves the eyes up and down within a range.</td>
</tr>
<tr>
<td>Ctrl_Eyes left/right</td>
<td>Moves the eyes left and right within a range.</td>
</tr>
<tr>
<td>Ctrl_Lids up/down</td>
<td>Moves the upper lids up and down. Shows alertness.</td>
</tr>
<tr>
<td>Ctrl_Lids left/right</td>
<td>Moves the lower lids up and down. Increases and decreases emotional</td>
</tr>
<tr>
<td>Ctrl_Brows up/down</td>
<td>Moves the brows up and down. Only applies contextually, has no guaranteed</td>
</tr>
<tr>
<td>Ctrl_Brows left/right</td>
<td>effect without other influences.</td>
</tr>
</tbody>
</table>

When I say context, I mean in plot-related scene, immediate situation, and also in physical surroundings. The eyes looking down when the brows are up and have a sad shape to them gives a different effect than they do when the brows are down with a mad shape—and further variations are possible by changing the height of the lids. Try to erase any preconceived notions of specific eye positions meaning different things, because right now we’re going to lay down new types of rules. With lip sync we had visimes, for most of the important shapes. Most of those have pretty solid definitions, but some, like R and T, had referential or relative definitions: wider than this, narrower than that. With the eyes, the level of focus or distraction is almost 100% referential and relative.

"Almost," I say, because there are a few rules.

Eye Rules: Focus and Distraction

Most everything I consider a rule for the eyes has to do with focus and distraction, both for the character and for the audience. There’s the focus as tied to the motion, there’s timing, and there’s involuntary distraction (which can rip an audience out of your scene).

Focus and Motion

The eyes move around, but not randomly. In real life when people are having a discussion and a person is darting their eyes around, their eyes aren’t in constant motion. They move, and they stop. After a period of time, they move again, but they stop again. It is highly unnatural behavior for our eyes to not focus on something, anything, if they can, which is what causes the moving and stopping as opposed to a constant, even scanning. The eyes are moving from one focus to another. I tell you this so that in the next sections dealing with specific instances of focus and distraction, you’ll realize that eye motion, even if it’s ongoing, is not constant. There are
pauses and breaks. The eyes cannot scan across a room; they must bounce from focus to focus. This is the nature of the movement. Disregard it and lose your audience. The one apparent hole in this methodology is when someone’s eyes are following something that is moving—which, really, is the same rule of focus; it’s just that the focus isn’t still.

Some of you may be thinking, as I myself did for some time, that this eye motion rule does not apply to stylized characters. Unfortunately, it does. Even the most ridiculously styled characters in CG must have eye behavior reflecting realistic human motion. The likely reason, I’ve come to realize, is the way that CGI looks. An eye in computer graphics, even a badly modeled and textured one, looks a lot like an eye. Maybe it’s the way computers have perfected specular highlights, maybe it’s the quality of renderers—who knows. All that matters is that since the eyeballs look like eyeballs, we expect them to behave that way.

Think of a green eyeball of a monster: Mr. Mike Wazowski. Even he, as odd and far from reality as he was, had realistic timing, motion, and acting in that big ol’ eye.

**Timing**

A focused character, besides having a posture that illustrates this, will behave in a focused manner in the face and especially the eyes. For animators, it can be very tempting to—well, animate. Sometimes the temptation to move things can ruin an effect we’re trying to create. Eyes generally move very quickly, but in creating the illusion of focus or intensity, we need to hold back. It is okay for a character to hold a stare for a while. By interrupting the stare too soon, we would dilute the intensity or sabotage the intensity we were after.

**Involuntary Distraction Is the Enemy of Performance**

Distraction is the enemy of performance. If the audience is distracted by anything born of our animation, they’re looking at the animation, not at the character in the scene, and they’re missing what’s happening. With most of the things you animate, like full body shots, you won’t have this problem, they’re not as susceptible to this. With the face and the eyes, though, there is so much potential for fatal distraction that you might find yourself focusing on what not to do rather than on what you want to do.

**Brow Rules**

The rights and wrongs, dos and don’ts for brows are pretty sparse, but here they are.

**Limit Your Range**

Try, as a conscious effort, not to ever let your brows get to the extremes of their range. It will happen, and for good reason, but if you stop yourself from maxing your brows out, you’ll force
yourself to be a little bit more resourceful and creative with all the tools at your disposal. I'm far more willing to believe a character who is sad than one who is the saddest he's ever been in his entire life, so sad that his face must hurt from the muscle contortion. I like to give myself that range to play with, but animation on the brow almost always looks better when it lives pretty close to the default shape. Also, as with the mouth, opposites and stepping all apply as simple good general animation principles. If you have a character who's mad on his first line of dialogue, then even more angry on the second line of dialogue, what can you do? If you blew all your range on the first line of anger, you're stuck on the second. Keeping things in a range helps a lot.

**Darting Motion**

Your brows don't move slowly. You can try it if you like, in a mirror. Try moving your brows up slowly, you can't. On the way down, it's easier, but still not very normal. Brows tend to jump into poses, hold that pose, and then drop back out of it.

**Sometimes the Best Shape Is No Shape**

My favorite CGI facial acting shot ever—so far—is in *The Lord of the Rings: The Two Towers*. Gollum is a sickly looking outcast, helping the current owner of his “precious” ring. There's a scene where he is talking to himself—not just musing, but clearly of a damaged and divided mind—and the camera cuts help differentiate the two personalities. In one moment, the whole thing went from looking like some of the most beautiful computer animation and motion capture, to surpassing all of that and becoming real. In one shot, Gollum draws back in the frame and just says “What?”

What made this scene stand out for me is that, for much of the film, the character's facial expressions, while wonderfully shaped and animated, were, well, *always* expressing—going from one extreme to another. There was never a moment's rest in the face. In that one shot, the character started with an angry expression, and an intense glare, and then bang! The muscle tension released, the eyes widened slightly. That was it. The animator resisted the urge to shoot to the opposite spectrum for effect; they stopped it in the area of “nothing,” no shape. It was the absence of a shape, the release of the tension, the character's real, genuine, tangible shock at the dialogue exchange that blew me away. The character had been ripped out of himself, for just a moment—a real reaction. It showed me something I might have known, somewhere deep down, but never quantified: getting out of a shape can be even more powerful than going into one. I've looked for ways to use this since, and it has been a remarkable tool in realizing certain emotions and moments. Hats off to whoever animated that scene—great work!
Order of Operations

This is the order in which I like to do things in regard to the face; there are some production issues, but I'll address those. Also, this list is not complete, as there are still mouth emotions to address, but that won't come until the last chapter; on this list they would appear right before finesse.

1. Sync
2. Head tilt (up/down)
3. Eyes
4. Eyelids
5. Brows
6. Finesse

Sync

I do my sync first, to get my timing down. This applies to all animation I do. If a scene is mostly pantomime, but there happens to be sound, I'll do the sync first; it helps me get into the timing and feeling before attacking big sweeping motions. I'll also sometimes create myself a dopesheet using my sync timing.

Head Tilt

I do this second, but there are a few catches to what second means. In a big full-body acting shot, I'll do the full-body acting after sync and this third, but in a close-up shot, I will do this second. I treat the tilt of the head as its own entity apart from the rest of the posing of the body. If I work on a floating head in a scene such as we'll do in a minute, up is up, down is down. If I'm working on a character, like the one in Figure 7.19, who is already posed, up and down is a range defined using that pose as the zero-line.

In this step in my order of operations list, I've written “up/down” only, and that’s because I don’t usually like to add in any other head movements until the rest of the steps for the face animation are completed. The up and down gives a good base motion, but after that, if you...
get the whole head swooping and turning all over the place, it can be hard to keep focus as you continue your work on other things, like the eyes and brows. This potential drawback to the process, we’ll actually use to our advantage later. By adding those extra head motions after we’ve done the rest of our work with the face, we’ll make the minute details a little harder to follow, and usually that, just makes them look better; you can’t sit and nitpick at a moving face! Sneaky, sneaky, sneaky.

Eyes

This is completely interchangeable in list order with the tilt of the head. In fact, I’ve only made them separate steps to keep the two thought processes separate for instruction. In my own animation, I do the two at the same time, but I only recommend doing that yourself after you’ve really learned to distinguish the individual goals. By getting the head and eyes moving early, which is all I’ve done in Figure 7.20, you get into the real feel of the scene before laying on the more obvious and uncreative brows.

Eyelids

This encompasses upper lids in both expression (wide, narrow) and function (blinks). This is the point where the emotion really starts to come through, as in Figure 7.21. We’re looking for excitement levels, good places to blink, just getting into the thought process of the character. The lower lids come in here, too, and add in all the thought and intensity that they do.

Brows

Last but not least on the explicit steps are the brows (Figure 7.22). I got in the habit of doing these last (these and mouth emotions) when I started to *really* get into facial animation. At first, doing these last was a teaching aid I forced on myself to learn about the other things on the face. It worked so well that I realized brows had actually been hindering my animation—they’re a crutch. At this point, I’ve just gotten used to putting them on at the end, and I recommend it. They can add a lot, but I really think of them as the last resort for creating an expression. Usually, they are the icing—at this point, after all the preceding steps, the expression is already there.

Finesse

Once all the pieces are in place there’s inevitably something that needs to be changed. If you’re doing it right, layered animation always has a little bit of do-over and repair. If you’re thinking so far ahead that you’re not doing things in your Eyes pass because of something you’re going to do in your Brows pass, you’re not giving each layer its proper, individual, unique attention—you’re animating straight-ahead out-of-order! This is where I will decide that part of a scene isn’t working; it’s where I’ll add in other motions on the head, and shift keys around to make thought happen before sound.
Example Animations

Well, since this is an eyes-and-brows chapter about acting, let’s act. We’ll start with a sound file and a scene from Chapter 4, “Visemes and Lip Sync Technique.” To be lazy about it, if you saved the scene you worked on there, you can import that and copy the curves from the locator “MouthControl” to your new “Ctrl_Sync” slider. The animation should come over fine. To get in practice, as you should, you can also animate the scene again. Personally, that’s what I recommend.

I’ll do quite a bit of explaining throughout this section, especially in the first example, where I’ve split up some of the steps to a few sub-steps to give every little thing attention. After that, I start to move faster, only explaining the things that are less obvious given the instruction thus far. These scenes could be taken further, but a lot of that last step is frame-to-frame finicking, which is not a fun thing to talk through and often comes down to “I just like it this way better!”—you can tweak these on your own.

For the rest of the chapter, you’ll need to refer to the animations on the CD. I’ll drop in pictures of frames from the animation here and there, but to get a feel for what I’m saying you really need to see and hear the motions.

For the rest of the chapter, you’ll need to refer to the animations on the CD. I’ll drop in pictures of frames from the animation here and there, but to get a feel for what I’m saying you really need to see and hear the motions.

If your scene is not lining up with my numbers, double-check that your frame rate is at 24 fps (film) in Window ➔ Settings/Preferences ➔ Preferences ➔ Settings. Also check that you’re playing back in real time, under Window ➔ Settings/Preferences ➔ Preferences ➔ Timeline.

“What Am I Sayin’ in Here?”

To start, import the “What am I sayin’ in here?” sound and/or scene you worked on before. For those of you starting fresh, you’ll find the sound, WhatAmISayinInHere.wav and .aif, in the Chapter 4 folder. For this scene I blocked my frame range at 0 to 35.

Time check: This process and result took approximately 20 minutes’ work.

A finished version of the scene file, WhatAmISayin.ma, is in the Chapter 7 folder on the companion CD. An AVI as each step is completed can also be found on the CD:

WhatAmI_01_Sync.avi
WhatAmI_02_Tilt.avi
WhatAmI_03_Eyes.avi
WhatAmI_04_Lids.avi
WhatAmI_05_Brows.avi
WhatAmI_06_Finesse.avi

I won’t have notes here about the Sync step in these sample animations, as that’s covered in the mouth chapters.

Copyright © 2003 SYBEX Inc., 1151 Marina Village Parkway, Alameda, CA 94501. World rights reserved.
NODDING
When I say “nodding,” it means not only dropping the head down, it means overshooting the pose, and then correcting. It gives a nice biting motion, and it’s something we people do a lot of in speech—we almost throw our head forward and then catch it, like a nod cut short.

Head Tilt
I've talked before of animating the head to the music of the dialogue; now I'll describe actually doing that. In this delivery of “what am I sayin in here,” the *what am I* sounds pretty even to me, in both tonal quality and volume. Listening to *sayin*, you can hear a pretty distinct jump in both volume and tone. For me, when the music goes up, so does the head. The sound of *sayin* is approximately from frames 12 through 18, so on frame 12, I'll set a key on the Ctrl_Face to tilt Box Head up. We don’t want to have this movement look like an exact relationship between the music and the head, so instead of dropping it again right away, I'll look to the next sound or two and see if they have a reason for me to keep the head up.

The next word, *in*, sounds about the same to me in tonal quality as *sayin*, so I'll hold the head up for that sound, too. Moving along, the next word is *here*. Here is a definite drop in tone, so on frame 25, I'm going to push the head back down, I think, even further down than level. Since *in* lasts until about frame 20, I'll set another head-up key on 20, leaving the motion between *in* and *here* to be 5 frames long. That's a pretty big motion in a pretty small space, so to keep it from looking odd, I'm going to turn that downward motion into a nod. To do that, I'll just bounce back up a little higher on frame 30, and hold that until 35, the approximate end of the scene.

When you’re animating the head to sync after the rest of the body has been animated, all these motions I’m describing can be applied on top of your existing posing. Just use the existing poses as the zero, or baseline, for the motions. Moving the head as part of sync can help you hold an overall body pose longer.

Listening to and watching that, most of it looks okay, but the head creeps up slowly from frame 0 (I set a default key on all sliders on frames 0, and 35 before I started, “capping the ends”). That slow creeping motion bugs me. What I decided to do was to hold the head lower until right before the first higher key. I set a low key (not super low, just a little bit lower than default) on frame 7. After that, just because I though it would look more like a pose and less like a drift, I put another similar low key on frame 2.
Eyes

The order in which you animate the parts of the eyes and brows is less significant than with the actual lip-sync, but do try to animate some head tilts and the eyes first. With the eyes, there are a million ways to go. I'm going to pretend, for this scene, that the character is trapped in a box and is addressing no one, or a crowd—there's no specific person he's talking to. To show that, I'm going to have him look around some.

I'm going to pick a few locations, basically at random, for the eye darts. Most eye darting, or looking around, happens perceptibly in the left to right more than the up and down, so I tend to favor picking locations closer to level. Eyes, as I mentioned earlier, go to places quickly and stick, so I tend to key into a pose, middle-mouse drag the time slider (to advance the time, but not the state), and set the same key again. I don't want to have the eyes move in timing with the tilts of the head; that would make the motions look like a dance. I moved the eyes (character) left on frame 3 and held them there only until frame 5; then on frame 7 moved them over to the right, holding that until frame 10, and finally brought them back to center on 13 and left them there for the duration of the scene. By having the character do most of the motion early and then centering for the last half, it creates the feeling that the character himself is wondering something, and asking that question of whoever he's looking at at the end, the only sustained position.

Eyelids

There are two parts to this: eyelid heights for emotional effect and, of course, blinking. Let's start with heights. This line has got an elevated tone throughout, so I'll likely leave the eyes slightly more “bugged.” I raised the eyelids on frame 4, and tapered them slightly (very slightly) down to frame 21. That's because the word here, although a tonal drop, does have a distinct volume hit. I want to make here have some impact, but in the same way that it's already impacting. In a little bit of an opposites approach, I lessened the incoming key, then on frame 24 jumped it back so the upper eyelids widen some more, and then hold that pose through the end.

Sometimes (though not always) bouncing eyelids up just to hit a single key causes them, during their return motion down, to look unnatural; that's why I chose to hold the pose through the end.
Now for blinks. One basic suggestion for when to blink is during big motions of the eyes. The range over which our character is looking most definitely meets that criterion. I'm going to blink the eyes by moving the Ctrl_Lids slider down on frame 2.

I'm not, however, going to blink on the second motion of the eyes; that would turn this into the blinky-blink-blink show. Generally, stay away from groups of blinks for functional reasons. For emotional effect they're great, but groups of blinks show disbelief, shock, confusion, etc. Since this guy is asking a question, he may be a little bit concerned, but I don't think he's in shock or disbelief. Putting a blink on the second eye move would cause an emotional side effect, so I left it out. My first instinct, moving forward, is to just leave the rest of the scene alone, but there is something else to consider. In conversation, there's a subtext in blinks.

When I say something, if I continue to stare at you without blinking, you won't know when it's your turn to talk. If I instead say something and blink, it shoots you the message, albeit subconsciously, "Okay, it's your turn to talk." If there's no blink, there's no message. It's another fun little experiment to try at home: talk and then don't blink. It's likely that you'll hear no response to your statement. In any case, it makes me want to blink the eyes near the end of this line. After scanning the line a few times, I'm realizing that exactly where we have the eyes widening on here is where I want to blink. That's fine, I'll just change the widening into a blink instead. The word here still gets its eyelid animation hit—it's just a blink instead of a widening.

The lower eyelids—the Squint—is an emotional intensifier; it adds thought. Using that approach, I'm looking for where thought should be communicated. Listening to the sound, and watching what I've already animated, the character seems to do his thinking up front, when he's darting his eyes around. Also, it's usually smartest to change lower lid poses at the same time as upper lid poses, making blinks perfect transitions. I animated the lower lids up (Ctrl_Lids left) from frame 2 to frame 21, then back to default on frame 24. It basically appears between the two blink keys. Another thing this did was to create more punch on the word here, as it's now getting a widening of the eyes. See how it's all relative? Since the lower eyelids were tight, going back to default looks wide.

**PRODUCTION NOTE**

I did it in this example, but in real-world production it's almost always a bad idea to blink in the first or last 5 to 10 frames of a shot unless you're expressly asked to by your director or supervising animator. Editors will murder you. Editors need some flexibility in exactly where to come into and out of your shot. If you put blinks in that zone, and the frame they choose to cut to/from has the eyes closed, it causes a "hook-up" problem with shots around it; extra work for you, and extra grief for them.
Brows

Watching the animation, you’ll notice that there already seem to be brow Up/Down motions due to the head’s Up and Down. Many people animate the brows to volume. Instead, animate the tilt of the head—it’s a very similar perception. The difference is that the brow Up/Down due to perspective in head tilts more accurately reflects reality, and the brows don’t look manic.

Use the brows mainly to reinforce. In this situation, I like the seeming raise in the brows created by the upward tilt of the head during sayin. I don’t, however, just want him to be “Mr. Brows in the Air,” so instead of pushing the brows up, I’ll push them down beforehand—this is basically using opposites, or treating it like an anticipation. I set keys for the brows Down on frames 4 and 10, and they return to default on frame 13, approximately at the right time for sayin.

Do not concern yourself too much with lining up all of your keyframes for poses on the same frame quite as stringently as you might on the body. There are few enough things to keep track of in the face that the inaccuracies actually make it look better, and it’s not very difficult to manage.

That’s about all I want to do with the brows. As an animator, I’d like to go in and key all over the place, but I don’t think it’ll add anything to the performance. I don’t look at it and feel a lack of brow Up/Down, so I’m not going to add any more.

On other setups, the brows will work together a little bit differently—you’ll create the mads and sads out of combinations of the shapes you have available. With Box Head, though, we’ve got some pretty simple stuff. Sad and Mad. Sad can double for a lot of things: the right smile with a subtle Sad on the brows can be happy; it also portrays shame. Sad generally portrays the softer emotions, or even the lack of confidence, which is the way I hear this line. The character is just a little bit confused, asking a question. Asking is a lesser form of pleading; they’re in the same category, one that indicates a little bit of weakness. Since the whole sentence is pretty much in the same tone, and I’d like to hit each portion a little bit harder, I’ll use stepping. I went to the end of the scene, choosing the most extreme sound and pose first, which I only want at about 70% strength for the shape. Then I backtracked. I set a key on 27 so that the pose holds until the end of the animation, then between 13 and 21 sayin in, I set some keys back up a level, about 40% to 50%, creating a “step.”

It was no coincidence that I chose the range between 21 and 27 for an expression change. I used the blink as a device to help change expressions more believably. Blinks are good for that.
From there I created another step, even higher, between 3 and 10 to give *what am I* some sort of impact, and left the key I already had on 0 that goes back to default. Watching the scene through, you don't see drastic motion on the brows, you just see some acting as the brow shape shifts slightly throughout the line.

**Finesse**

So here's where there are really no rules, and it's up to what I or you like and don't like. I'll add in some motions on the head left to right, and see what it feels like. In this stage, you should really have something that you're reacting to on an emotional, not functional, level. If your character doesn't seem at least a little bit alive, take a look at each step again, seeing if it can steer you toward something you missed or could use more or less of.

**Move the head like the eyes** Not in all cases, but in some, I like to move the head along with the eyes. Making the head reach a little bit as the eyes move really takes away the feeling of the character wearing a neck brace. In this scene I'm only going to move the head left to right, as that's where the eyes are looking. I moved the head (character) left on frame 4, then (character) right on frame 9, and then back to the middle on frame 13. Leaving the head fairly still, or at least facing forward during the last part of the line, where I have Box Head addressing the screen/audience, gives it some focus.

**Scene choice** Next, looking at the scene, I decided I really liked the bug-eyed look for the delivery, so wherever the eyes are wide I made them wider.

**Making thought happen first** This scene is too short to bother trying to move the shifts in expression ahead. In short scenes, you should be more concerned with the overall expression being pretty homogenous, so that it will read in the short time an audience will see it. I'm going to leave this as it is. In longer scenes, by shifting the acting portions of your animation ahead, you can create the effect that the character *thinks* before they *do*.

---

Here's something really funny you can do later: By copying the animation curves from these sliders to sliders on some of the more refined looking setups, you can actually recycle this animation onto a photo-real or any kind of head if you like. It's funny to see Box Head performing the same line side-by-side with another character!

---

I think we can all agree that what we have here is not going to win any awards, but I think we can also agree that we got very far very fast. That is the goal at this stage of the learning, so let's keep on it!
Beautiful Perfect

“Listen up buddy, there’s two kinds of people in this world: big dumb stupid heads like you, and super beautiful perfects, like me!” Woosh! That’s some snarky attitude for a little girl!

Since the other two sound files from Chapter 4 are both also very short questions like the last example, I’m going to move right along to some other sound files that can provide more instruction. To proceed, import BeautifulPerfect.wav from the Chapter 7 folder on the CD into your Box Head scene. I put my scene range at 0 to 250. A finished version of the scene file is on the CD as well: BeautifulPerfect.ma.

Time check: This should take, on your own, about 30 to 45 minutes total.

An AVI of each step as it’s completed can be found on the CD:

- Beautiful_01_Sync.avi
- Beautiful_02_Tilt.avi
- Beautiful_03_Eyes.avi
- Beautiful_04_Lids.avi
- Beautiful_05_Brows.avi
- Beautiful_06_Finesse.avi

Head Tilt

I love to animate to the actress in this sound piece, because she’s very musical in her delivery, and you know I like to use those musical sounds. For Listen up, there’s an upward shift in tone during listen and it’s sustained through up, so I tilted the head up and kept it there. Buddy provides a fantastic shift down, in both her tonal quality and in how sharp it is. The listen up has unwittingly become a great anticipation for buddy. For the next big chunk, there’s two kinds of people in this world, there is a nice little punch on her delivery of two, and another on people. You can’t hit every shift with the head, but you can stow those two sounds away for different tools, such as some of the later brow and eyelids stuff. I tilted the head higher for the time before people, and then shot back down again on that word. I held that height until after world, where there’s a silence, and the actress clicks her mouth.
This is the bread and butter. This is the good stuff. You should hope to always be so lucky as to have an actress to pause and click her mouth between lines. The perfect time to shift expressions is between lines, or phrases, almost never during. When an actor makes a noise, takes a breath, does anything in between lines, you are given a playground to do with as you please. You can bounce the character into an extreme pose, for just that sound, if it’s fitting. You have a perfect, infallible spot to change expression, which otherwise can sometimes be hard to find, and that’s what we’re going to use it for. For this stage, it’ll just be moving the head up, but we’ll do something at this point on every pass through.

Big and dumb both climb tonally, so I’m going to step the head higher into those both, and then slam it back down with a nod on stupid. Heads like you only really peaks on like, so I kept the head at the same level as after stupid and then popped it up briefly on like, inadvertently causing a nice nod on you.

For the next section, and super beautiful perfects like me, the character is obviously off in world of her own wonderfulness, so I’d say, posing her head toward the sky is a good idea. I stepped it down to ease in the downward movement over perfects, and then brought it back down in another nod on me.

Eyes
The scene implies that she’s talking to someone, and since it’s not important who it is or where they are, I just picked a place, somewhere off screen left, that became the eyes’ home base. Now, through this performance, she seems pretty sure of what she’s saying and who she’s saying it to, so I held her eyes pretty much on that one focus. During the spots where she’s obviously searching for the words big dumb and super beautiful perfects, I darted her eyes up and around. I picked two spots away from whoever she’s talking to. I shot her eyes up and (screen) left for big, then up and (screen) right for dumb. Knowing how eyes move, they only take two frames or so to get to each location, and then hold there until they move again. I did almost the same thing for the second “search” for super beautiful perfects. I returned her gaze to her off-screen focus, for me, as the nod provided a great time to do so.

Eyelids
For listen up buddy, the upper lids, much like the head, shoot wide open for listen up, and are dropped lower for buddy. Later on, with there’s two kinds of people, I decided to punch the dismissive, contemptuous nature of the sound, by intensifying her expression with a squint, in two steps, on two and people. From there nothing eventful happens until she looks up on big dumb. For that, I blinked right in line with that clicking sound she makes. I adjusted the lower lids slightly, to track upward in relation to that eye movement.

The eyes return to her primary focus on stupid, so to transition her back into “reality,” I gave her another blink. A blink paired with a nod of the head, and a change in focus of the eyes, really starts to show a strong acting transition there, which is good. I also used the
I really wanted to intensify her through *listen up buddy*. I felt that she wasn’t telling her focus *what’s up*, and the dialogue really is telling somebody *“the deal.”* I dropped the brows low, but didn’t give them any real expression. Starting at *there’s two kinds* I gave the brows a little bit of sad shape, which, with the brows down low, and the head tilted forward, and the kind of line this is, creates an air of arrogance. Remember, I was looking for a way to hit that part of the line earlier in the process—and finally found it here! I both raised and saddened the brows for *big dumb*, using that blink and mouth click as the place to transition, which is now turning into a great little attitude moment. As she returns down, there’s really two things to accent, *stupid* and *you*. To save myself range, I decided to not drop the brows on *stupid*, but instead just shift them to angry, and then drop them and lose the expression on *you*. The reason I did it that way instead of dropping them first and then adding mad on *you*, is that I liked the look of the dropped expressionless brows better, and putting them second, makes that expression more her “final” destination than a transitional pose. This last pose also looks like the expressions near the start, giving her a more consistent performance.

The next shift is the skyward gaze, for which I did a pose similar to the one I did for the first. It’s a good idea to do that if you can; it creates almost an anime three-frame cycle, where you bounce between your established poses. Used well, going through your three-pose cycle strengthens the scene—people are more likely to remember it. Just don’t do it for *everything*!

**Finesse**

For this one I was pretty happy with the overall feeling, so all I did was put some of the left-to-right motions of the eyes into the head movement as well. After that, since this scene is a little longer, I moved all of the animation three frames earlier, just to see what would happen, if the illusion that thought came before action would work. In the emotion, the eyes, and the
head, it was great, but my sync fell out of—well, sync. I hit Undo, and then shifted only the other four sliders (excluding Ctrl_Sync) ahead, and that worked great. That few frames of difference really helps the mind behind that square.

**Default Grey**

So, if you were in a world filled with colorful, photo-real, perfectly textured models—with hair and shaders and soft-body dynamics and all that jazz—wouldn’t you be a little grumpy to just be a grey box? Box Head is. From the companion CD, import **DefaultGrey.wav** into a scene with Box Head. I blocked the range at 0 to 550 frames. A finished version of the scene file is on the CD as well: **DefaultGrey.ma**.

“I’m default grey. Stupid grey. Boring. Doof. You’ll get yours, red. Flashy, oo! Look at me, I’m red! Oh you, srr err razafraz…”

**Time check:** This should take almost a full hour from start to finish.

An AVI of each step as it’s completed can be found on the CD:

- DefaultGrey_01_Sync.avi
- DefaultGrey_02_Tilt.avi
- DefaultGrey_03_Eyes.avi
- DefaultGrey_04_Lids.avi
- DefaultGrey_05_Brows.avi
- DefaultGrey_06_Finesse.avi

**Head Tilt**

This is the first example involving a big breath. I treat breaths just like musical sounds: an inhale is up and an exhale is down. For this opening sigh of discontentment, I crept the head up until the peak, and then dropped pretty swiftly on the exhale. The first actual phrase, *I’m default grey*, also has a great up and down to it. As with all sounds like that, I crept the head up during *I’m default* and then nodded the head down on *grey*, right where the sound levels out. It gives the word some impact, just like the vocal performance. After that, the actor makes a sheesh, or quick exhale sound, *I’m going to do a motion like a nod, but upward, as if he’s tossing that sound out. It visually matches the sound and its “whatever” tone. I’m going to drop the head for stupid, and then do another of those reverse nods for grey*. When an actor delivers a scene consistently, you’re likely to run into these repeated sorts of motions. Until *boring*, there’s a hold, nothing big happens, but *boring* is tossed out pretty hard, so I decided to nod on that sound but return the head to where it was previously. I did the same on *doof*. To get more impact on *doof*, though, I actually crept the head higher after *boring*. To nod the head down to the same level as *boring* was a bigger movement from this higher start-point.
All through the *oo flashy oo look at me I'm red*, I crept the head higher and higher, but I bounced it up and down as I did. The sound was very banshee-sounding with warbling, so I mimicked that in the head's up and down motion. After that the actor breaks into a lower-level *oh you, son of errr arr* and various other noises. I just dropped the head down for that, and that was the end of my work on the head Up and Down for now.

**Eyes**

I dropped the eyes for the defeated-sounding sigh at the start. Now, with all these things going on, this guy's really starting to look pathetic Eyes down, as I've said before, doesn't automatically create sadness, it just works sometimes,—like now. I decided to make straight down his “reality” point, so I held it for a long time; that makes it look as if he's actually focused on something. What it is is irrelevant, but it's something. When he then moves his eyes (character) right briefly, that just looks like where his eyes settled as he was thinking, not necessarily a focus. I moved the eyes there for the *sheesh*, and then quickly moved them to the other lower corner on *stupid*, and then picked another position on (character) left as yet another sort of “thought” point for *grey*. He stays there through *boring*, and then goes back to his dejected “home” position on *doof*.

Next was a very specific timing thing. I'm not crazy about characters looking at each other too intently if it's not clear why they would. I have Box Head look at whatever “red” item is next to him, but made the shift on the word *yours* before *red*. I could have done it earlier in the line, but that might denote some real conflict between Box Head and the color red. By making it ever so slightly before the word, it creates more of a sense that he's just angry and looking for someone to blame. I thought that was a better direction. If you want to see the difference, in your scene make the eyeline change earlier; the sense of more contempt and history between Box Head and “red” is obvious.

From here, the eyes stay on their new home focus until he gets into the heavy mocking sounds, where I shot the eyes upward. Mocking often leads to eyes upward; I don't know why, it's just an established thing in both life and cartoons. As the warbling sounds continue, I moved the eyes back toward his focus, and held them there for the rest of the scene. This now does what I was talking about earlier where I chose not to shoot the eyes over too early. He's really decided to make it personal, so now that's fitting. It also was a form of stepping over several poses. By not having “red” be the object of too much intensity earlier, we can go back to that pose and make it stronger with a hold, ending on a stronger note.

**Eyelids**

I don't often blink character’s lids slowly, but a big exhale is one of the times it fits. I blinked the eyes slowly so that the fully closed eye was right on the peak of the upward head motion for the sigh, making the tilt down seem even longer and more painful, drawn out. If I did it
later, it would cut that time visually. Using my friend’s technique of hitting percussive or closed mouth sounds with blinks, I hit the m in I’m with a blink. I also blinked again on the first grey, the nod seemed like a good place to throw in a blink (nods usually are, the two actions strengthen each other).

Other than that, I left the lids until the word stupid. On stupid, I brought up the lower lids, creating a slight squint, just for the one word, giving the character extra contempt for a moment, which seemed to be in the vocal performance anyway. Boring was the next sound I keyed on; I blinked, and on the blink return brought the lower lids up, too. The combined head nod, blink, and change now in pose is making boring really have some punch. I left the lids as-are except to move the lower lids out of the way as Box Head looks down, until oo flashy. As there’s a real attitude shift from anger to mocking, I widened the eyes there, creating a sarcastic feeling. They stay there until he looks back down, where I blinked for the transition (it’s always a good idea to blink on emotional transitions).

After that, and for the rest of the scene, I pulled the lower lids up and upper lids down slightly, creating more of a narrow look for the eyes, clearly an angrier appearance.

Brows
For the first portion of the line all the way up to but not including stupid, I just put the brows in a sad pose and punctuated the head movements. On grey, I dropped the brows low, and removed the sad expression, so they were level. Happening over the tightening of the lower lids; this created a great emotional shift. You can see him going from unhappy about his colorless situation to angry about it, even though I didn’t go as far as to actually turn the brows to the mad side. On you’ll get yours, red, I actually made the brows angry, dropping in a hint of the pose I’ll return to at the end, and adding some strength to the statement.

For the whole mocking section, I moved the brows up and sad, creating a decidedly weaker appearance, perfect for mocking. I accented various words and sounds, but nothing major. As he finishes up his little mocking moment, I pulled the brows back down and into an angry pose. I was tempted to bounce the brows along with the various interesting sounds, but it looked stronger to leave them held in that position.

Finesse
This, I decided needed work, and that’s a normal part of the process. I didn’t feel the shifts in emotion as strongly as I wanted to, and I also didn’t feel as if some of the emotions themselves were really as strong or as linked to the sound as they should have been. First off, the easiest thing was to begin with the head left-to-right motions. For those I started by copying the motions of the eyes. (I literally copied the FCurve and shrunk it down.) After that, there’s something I like to do during disbelief, sadness, anything with which the character
doesn’t really agree; I shake the head. Just shaking your head like saying “no” is a great little subtlety. During *I’m default grey* I threw in some shaking. I also did the same at the end during the mumbling nonsense. The muttering paired with the shaking and the angry expression turned into feeling almost like disapproval more than anger, and I thought it fit really well.

Something else that jumped out at me was the sigh at the start. The brows seemed to hold tension by staying up, instead of releasing tension along with the sound and the head motion. I decided to leave the brows’ upward climb, but then I dropped the brows. I made the drop happen after the head was down. By making the drop on the brows later, I really dragged out the defeated impression, and it also made it less a flex and more of a release. If it all happened at the same time, he’d be moving into a pose instead of falling into defeat. This also gave me an opportunity to use the brows to accentuate some of the sound in the long hold following that. By adding a brows Up motion on *I’m default*, it just accentuated all that was going on elsewhere in the face, on both the Up for that and the Down on *grey*. Dropping the brows at the same time as dropping the head, at the same time as the blink, and all of that in time with the sound works well for me.

After all that I just slid the emotion stuff up a few frames, so the thought happened before the sound, and I was done!

**Continuing and Practicing**

We’ll continue this in Chapter 13, “A Shot in Production,” where we take more shots through a facial animation process from start to finish. Now that you’ve got a feel for the type of expressions you can create using combinations of techniques, it’s time for us to move into the process of building the other most important area of the face, the eyes and brows, and the keys that area needs.

If this chapter has done anything, I hope it has shown you why I leave the more obvious things like brow poses for later, and things like smiles and frowns for even later. I really hope this has shown you how much emotion you can create with very little, even with the complete absence of a smile or frown!

To continue on with practice, there are more sound files available all over the CD, mostly in Chapter 13. Another thing I frequently do for practice purposes is record sound off movies and TV to sync to. Commercials are actually my favorite, as they usually self-contain most lines. Pulling from a movie, you can run into a minute-long line that doesn’t mean too much out of context, whereas in a commercial, it’s all wrapped up for you in a few seconds and makes some sense. Something I don’t recommend, though, is to rotoscope your acting from the actors on-screen; it can actually block your creativity, because what the person is doing fills your head with those motions instead of you being able to make up all new ones that relate to the sound.